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Installing CD One

This chapter consists of:

• Installation Overview

• Preparing to Install CD One

• Performing a New Installation

• Performing an Upgrade Installation

• Verifying the Installation

• Removing CD One
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Installation Overview
Table 2-1 is an overview of CD One installation tasks. It contains references to 
more detailed information about each task.

Installation Notes
During installation, you might see warnings from the Windows NT system that it 
has found a read-only file. You can choose Yes to overwrite the file, No not to 
overwrite the file, or Cancel to cancel the installation. If you cannot continue the 
installation, call your technical support representative for assistance.

Table 2-1 Installing CD One Task Overview

Task Steps References

Prepare to install 
CD One.

1. Verify that server requirements 
are met.

“Prerequisites” chapter, “Server 
Requirements” section on page 1-3 

2. Install required Microsoft 
software on the server if it is not 
already installed.

“Installing Required Microsoft Software” 
section on page 2-3 

3. Verify that client requirements 
are met.

“Prerequisites” chapter, “Client 
Requirements” section on page 1-4 

4. Note TCP ports that 
CiscoWorks2000 uses and check 
for conflicts with existing 
applications.

“TCP and UDP Ports Used” section on 
page 2-5 

Install server 
software.

Run installation program. “Performing a New Installation” section 
on page 2-6 

Verify and 
troubleshoot 
installation.

1. Verify that correct files and 
directories are installed.

“Verifying the Installation” section on 
page 2-12 

2. Analyze installation error 
messages.

“Troubleshooting the Installation” 
appendix, “Understanding Installation 
Messages” section on page A-4 
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You might also see warnings that the installation system is running out of disk 
space. You can choose to free disk space on the system and click Yes to continue, 
or click No to exit the installation.

CD One is installed in the default directory C:\Program Files\CSCOpx. If you 
select another directory during the installation, CD One will be installed in that 
directory.

Preparing to Install CD One 
Before you install CD One, make sure your server and client environments meet 
the hardware and software requirements described in the “Prerequisites” chapter. 

Do not:

• Use DHCP running in dynamic mode on the CiscoWorks2000 Server.

• Install CiscoWorks2000 on a system that is configured as a primary or backup 
domain controller.

• Install CiscoWorks2000 on a FAT file system.

Note If you are running HP OpenView, the installation might take 
significantly longer to complete. Please stop all HP 
OpenView services before installing CD One.

Installing Required Microsoft Software
Depending on your system, installing the software might require three or more 
Microsoft software application installations.

The major steps required for installing the CD One software are:

1. Make sure the system has Microsoft Windows NT Server 4.0, Microsoft 
Windows NT Workstation 4.0 (US English or Japanese versions), or 
Microsoft Windows2000 installed.
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2. If you’re running Windows NT, make sure Service Pack 5 or 6a is installed. 
To verify the currently-installed Service Pack:

Note You do not need to remove previous service pack versions.

a. Select Start > Programs > Administrative Tools > 
Windows NT Diagnostics.

b. Select the Version tab.

If Version 4.0 Build 1381: Service Pack n appears (where n is 5 or 
6a), Service Pack 5 or 6a is already installed.

If this information does not appear, Service Pack 5 or 6a is not installed. 
Install one of them now. Refer to the Microsoft web site.

Note When installing the service pack, select either the 
Standard 40 bit encryption or the High 128 bit 
encryption. If you have previously installed 128 bit 
components on your system, download the High 128 bit 
encryption version.

Caution If you are not familiar with the Windows NT 4.0 service packs, refer 
to the Microsoft Web site for additional information. If you install 
the software incorrectly, you will be unable to install CD One 
successfully.

3. Make sure Internet Explorer 5.0 or 5.01 is installed and running JVM version 
5.0.0.3167 (or current shipping version).

– To verify the JVM version, Select View > Java Console.
If Java Console is not listed in View, enable it now: Select 
Tools> Internet Options> Advanced. In the Java VM section, select the 
Java Console option. Restart Internet Explorer.

– To download the supported JVM version, refer to the Microsoft web site.
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Note The download and installation programs for these required 
software packages are subject to change by Microsoft at any 
time. For this reason, it is not possible to provide exact 
instructions for the installation of the required Microsoft 
software.

Key Installation Points

Remember these points when installing the required server software:

• Always keep the newer file whenever you are prompted by an installation 
program to replace a newer file with an older file.

• Always reboot your system when you are prompted to do so by an installation 
program.

• You might be asked to register with Microsoft before downloading some of 
the required software. Complete the registration as you wish. Selections you 
make during registration will not affect the installation.

TCP and UDP Ports Used
In addition to the standard network ports, CD One uses the following TCP and 
UDP ports:

• 42340/tcp (CiscoWorks2000 Daemon Manager, the tool that manages server 
processes)

• 42341/tcp (Open Server Gateway)

• 42342/udp (Osagent)

• 42343/tcp (Jrun)

• 1741/tcp (the port used for the CiscoWorks2000 HTTP server)

See the “Preparing to Use CD One” chapter for information about accessing 
the server.
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Performing a New Installation
The CD One installation program takes approximately 30 minutes to complete on 
a PC with the minimum required hardware. This can extend to 1 hour if you 
perform network management integration during the installation process. 

Running the Installation Program—New Installation
To run the installation program:

Step 1 Insert the CD One CD-ROM into a CD-ROM drive. 

The Installer screen appears.

Step 2 Click Install to continue. The Welcome screen appears.

Step 3 Click Next to continue. The Setup Type dialog box appears.

Step 4 Select one of the following:

• Typical to install all CD One components in the default location
(See the “Typical Installation” section.)

• Custom to select optional components and to specify the location
(See the “Custom Installation” section.)

Typical Installation
If you select the typical option: 

Step 1 Click Next to continue. The installation script checks dependencies and verifies 
your available disk space. Then the Start Copying File dialog box appears, 
verifying current settings.

Step 2 Click Next to continue. The Setup screen appears, displaying the installation 
progress, then the Integration Utility dialog box appears.
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Step 3 Select one of the following:

• Later to integrate with a third party NMS after installation 
If you select Later, go to Step 4.

• Now to integrate with a third party NMS during installation
If you select Now, continue with steps a through c.

a. Click Next to continue. The Integration Utility dialog box appears, displaying 
a list of adapters.

b. Select the adapter from the list of available adapters, or select other to choose 
an adapter that is not listed (you will be prompted to enter the path name of 
the adapter), or select none to integrate after the installation is complete.
If you select none, go to Step 4.

The Integration Utility dialog box appears, asking if you want to enable 
download options from the Cisco Web page (CCO).

c. Select one of the following:

• No to not enable future upgrades from the Cisco Web page. 

• Yes to enable future upgrades from the Cisco Web page.
Enter your CCO user ID and password.

Note You must have CCO login privileges. If you do not have 
a user account and password on CCO, contact your 
channel partner or enter a request on the standard CCO 
web site (www.cisco.com).

Step 4 Click Next to continue. A Requirements Verification screen appears.

Step 5 Click OK.

Note A dialog box might display services that are running. To stop 
the services and continue the installation, click Yes.

When the installation is complete, the Restart Windows dialog box appears, 
asking if you want to restart your system. 

You must restart your system when installation is complete to restart the 
processes.
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Step 6 Select Yes, then click OK.

CD One is installed in the default directory, C:\Program Files\CSCOpx.

Step 7 Prepare the client system for use. See the “Preparing to Use CD One” chapter.

Note You must restart your system when installation is complete to 
restart the processes.

If errors occurred during installation, check the installation log located in the root 
directory on the drive where the operating system is installed. The default is 
C:\cw2000_in001.log. Each installation creates a new installation log that is 
saved as a different file. For example, the second time you install CD One, the 
installation log is saved as C:\cw2000_in002.log. For troubleshooting 
information or to verify the directories installed on your system, see the 
“Troubleshooting the Installation” appendix.

Custom Installation
If you select the custom option:

Step 1 Click Next to continue. The Select Destination dialog box appears.

Note If CD One has previously been installed on this machine, the 
Select Destination dialog box will not appear and the 
product will automatically be installed in the same location 
CD One was previously installed.

Step 2 Click OK to accept the default location, or select a different location then click 
OK. The Select Components dialog box appears.

Step 3 Select one of the following:

Note If CD One has previously been installed on this machine, the 
list of components will be different.
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• NMS Integration Utility to install only the Integration Utility
(For information about the Integration Utility and third party NMS 
integration, refer to Using CiscoView.) 

• Common Management Foundation (CMF) Base Desktop to install a 
subset of CMF
(Select this option only if the application you’ll be installing next requires the 
CMF Base Desktop.)

• Cisco View to install Cisco View and the CiscoWorks2000 Server support

• Typical Installation (all components) to install all CD One components
(Recommended for most systems)

Step 4 Click Next to continue. 

The installation script checks dependencies and verifies your available disk space. 
Then the Start Copying Files dialog box appears, verifying current settings and 
selected components.

Note If you selected the Cisco View or the CMF Base option, go 
to Step 7.

Step 5 Click Next to continue. The Setup screen appears, displaying the installation 
progress, then the Integration Utility dialog box appears.

Step 6 Select one of the following:

• Later to integrate with a third party NMS after installation
If you select Later, go to Step 7.

• Now to integrate with a third party NMS during installation
If you select Now, continue with steps a through c.

a. Click Next to continue. The Integration Utility dialog box appears, displaying 
a list of adapters.

b. Select the adapter from the list of available adapters, or select other to choose 
an adapter that is not listed (you will be prompted to enter the path name of 
the adapter), or select none to integrate after the installation is complete.
If you select none, go to Step 7.

The Integration Utility dialog box appears, asking if you want to enable 
download options from the Cisco Web page (CCO).
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If you are installing only the Integration Utility, enter the CiscoWorks2000 
server name and HTTP port.

c. Select one of the following:

• No to not enable future upgrades from the Cisco Web page. 

• Yes to enable future upgrades from the Cisco Web page.
Enter your CCO user ID and password.

Note You must have CCO login privileges. If you do not have 
a user account and password on CCO, contact your 
channel partner or enter a request on the standard CCO 
web site (www.cisco.com).

Step 7 Click Next to continue. A Requirements Verification screen appears.

Step 8 Click OK.

Note A dialog box might display services that are running. To stop 
the services and continue the installation, click Yes.

When the installation is complete, the Restart Windows dialog box appears, 
asking if you want to restart your system.

You must restart your system when installation is complete to restart the 
processes.

Step 9 Select Yes, then click OK.

CD One software is installed in the default directory, C:\Program Files\CSCOpx, 
or the directory specified.

Step 10 Prepare the client system for use. See the “Preparing to Use CD One” chapter.

Note You must restart your system when installation is complete to 
restart the processes.
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If errors occurred during installation, check the installation log located in the root 
directory on the drive where the operating system is installed. The default is 
C:\cw2000_in001.log. Each installation creates a new installation log that is 
saved as a different file. For example, the second time you install CD One, the 
installation log is saved as C:\cw2000_in002.log. For troubleshooting 
information, see the “Troubleshooting the Installation” appendix.

Performing an Upgrade Installation
Upgrading from previous versions of CiscoWorks2000 (prior to CD One, 1st 
Edition) involves the following major steps:

Step 1 Install the additional required software.

Caution If you’re running Windows NT, make sure Service Pack 5 or 6a is 
installed before you remove the previous version of CD One. 
CD One will not install without Service Pack 5 or 6a on 
Windows NT. 

Step 2 Run the CD One installation program.

Note If you’re upgrading from a previous version of CD One, see 
“Performing a New Installation” section on page 2-6.

Running the Installation Program—Upgrade Installation
During an upgrade from a previous version of CD One, the data is preserved. 
However, during an upgrade from previous CiscoWorks2000 applications (prior 
to CD One, 1st Edition), previous product versions are removed, but the database, 
ANI information, community strings, user and host information, and 
application-specific data files are preserved and will be restored during the new 
product version installations.
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To upgrade from a previous version of CiscoWorks2000 (prior to CD One, 1st 
Edition):

Step 1 Install the required software as described in the “Server Requirements” section on 
page 1-3.

Step 2 Install CD One as described in the “Performing a New Installation” section on 
page 2-6.

The installation program detects and lists any previous product versions installed 
on your system. You are asked to confirm.

Step 3 Select Yes. 

Step 4 Enter the directory name where the database will be stored, then click Next.

The installation program copies database files and stores them in the specified 
location and then uninstalls the previous product versions. You are asked to 
confirm.

Step 5 Select Yes. The Setup Type dialog box appears.

Step 6 Select one of the following:

• Typical install all CD One components in the default location
(See the “Typical Installation” section.)

• Custom to select optional components and to specify the location
(See the “Custom Installation” section.)

Note If you cannot install CD One, see “Troubleshooting the Installation” 
appendix.

Verifying the Installation
You can verify product installation by entering net start from a DOS prompt. The 
following services should be displayed:

• Apache WebServer

• CMF rsh/rcp service
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• CMF syslog service

• CMF tftp service

• CW2000 Daemon Manager

• CW2000 VisiBroker Smart Agent

• JRUN Proxy Server for CW2000

Note If you installed the CMF Base Desktop only, CW2000 VisiBroker 
Smart Agent will not be displayed.

Removing CD One
Use the Uninstall option to remove CD One files and settings.

Caution You must use the Uninstall option of the CD One installation 
program to remove the product. If you try to remove CD One or its 
components manually, you can damage your system.

Step 1 From the Windows desktop, select 
Start>Programs>CiscoWorks2000 >Uninstall CiscoWorks2000. 

The Uninstallation dialog box appears, displaying installed components.

Step 2 Select each component you want to remove.

Step 3 Click Next to begin uninstalling, then click Next again.

Messages about uninstall preparation appear and the uninstallation finishes. 
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